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You Selected the following Classes: Summer 2025
 

"C" in first column denotes a closed course.
“NR” in the first column denotes “No Registration” - the registration period for this course has passed.
“SR” in the first column denotes “Student Restriction” - clear holds on your account that prevent registration. If no holds exist contact the Office of the Registrar.
"R" in second column denotes a restricted course. See department for course pass.
“W” in second column denotes the course has waitlisting.

- Special information about a course section will appear in a blue box beneath the course section number.
- To see prerequisite,corequisite,and departmental information, click the section Title.
- Refer to Mtg Dates column for class starting and ending dates.

To Print the Schedule of Classes:
1. Go to File->Page Setup, click on Landscape then click OK
2. Go to View->Text and set text size to Small or Smaller
3. Go to File->Print

Architectural Sciences-- Fullfills Colonnade Category...E-AH: Arts & Humanities
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41459 AS 180 M75 3.00 INTRO TO ARCHITECTURE WEB N/A Yes TBA  WKU Web Crs 10 35 Mansour, O 05/12-06/13
Art-- Fullfills Colonnade Category...E-AH: Arts & Humanities
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42341 ART 100 B75 3.00 ART APPRECIATION WEB N/A N/A TBA  WKU Web Crs 13 12 Nichols, M 06/02-06/27
  42359 ART 100 C71 3.00 ART APPRECIATION WEB N/A N/A TBA  WKU Web Crs 3 27 Cartwright, I 07/07-08/08
Dance-- Fullfills Colonnade Category...E-AH: Arts & Humanities
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42617 DANC 110 B70 3.00 DANCE APPRECIATION WEB N/A Yes WEB  WKU Web Crs 5 25 Patsfall, A 06/02-06/27
Film-- Fullfills Colonnade Category...E-AH: Arts & Humanities
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41241 FILM 105 B71 3.00 FILM APPRECIATION WEB N/A N/A TBA  WKU Web Crs 5 15 Thomason, S 06/02-07/03
 R 41391 FILM 105 D01 3.00 FILM APPRECIATION Bowling Green N/A N/A TBA MTWRF 12:30 pm-02:10 pm 0 25 Thomason, S 07/08-08/07
Class restricted to Summer Scholar students This section of FILM 105 must be taken with COMM 145 41377
  41831 FILM 105 M01 3.00 FILM APPRECIATION WEB N/A N/A TBA  WKU Web Crs 4 16 Thomason, S 05/12-05/30
Music-- Fullfills Colonnade Category...E-AH: Arts & Humanities
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  32122 MUS 120 B71 3.00 MUSIC APPRECIATION WEB N/A N/A WEB  WKU Web Crs 1 18 Herbert, S 06/02-06/20
  38271 MUS 120 C77 3.00 MUSIC APPRECIATION WEB N/A N/A WEB  WKU Web Crs 5 14 Hondorp, P 07/07-07/25
  40982 MUS 120 M71 3.00 MUSIC APPRECIATION WEB N/A Yes WEB  WKU Web Crs 6 13 Alvarez, H 05/12-05/30
Spanish-- Fullfills Colonnade Category...E-AH: Arts & Humanities
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42552 SPAN 175 M71 3.00 ID IN SPAN-SPEAKING COUNTRIES WEB N/A N/A WEB  WKU Web Crs 0 20 Sunkin, F 05/12-05/30
Biology-- Fullfills Colonnade Category...E-NS: Natural & Physical Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42621 BIOL 113 C70 3.00 GENERAL BIOLOGY WEB N/A Yes WEB  WKU Web Crs 14 26 Sharma, N 07/07-08/08
The above course is an Online (Web) course.
  42625 BIOL 120 A73 3.00 BIOL CONC CELLS METAB GENETICS WEB N/A Yes WEB  WKU Web Crs 9 31 Srivastava, A 06/02-07/03
The above course is an Online (Web) course.
C  41482 BIOL 131 A70 4.00 HUMAN ANATOMY & PHYSIOL WEB N/A Yes WEB  WKU Web Crs 36 0 McDaniel, K 06/02-07/03
Lab, Clinical or additional class required with above class.
The above course is an Online (Web) course.
C  41483 BIOL 131 A71 0.00 HUMAN ANATOMY & PHYSIOL WEB $20 Yes WEB  WKU Web Crs 36 0 McDaniel, K 06/02-07/03
The above course is an Online (Web) course.
  42631 BIOL 207 A70 3.00 GEN MICROBIOLOGY WEB N/A Yes WEB  WKU Web Crs 11 29 Sharma, N 06/02-07/03
The above course is an Online (Web) course.
Chemistry-- Fullfills Colonnade Category...E-NS: Natural & Physical Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 40486 CHEM 101 970 3.00 INTRO CHEMISTRY On Demand N/A Yes TBA  TBA 0 20 Skipworth, C www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  41423 CHEM 101 M70 3.00 INTRO CHEMISTRY WEB $15 Yes TBA  WKU Web Crs 9 21 Burris, S 05/12-06/06
C  38113 CHEM 109 M71 4.00 CHEMISTRY/HEALTH SCIENCE WEB N/A Yes TBA  WKU Web Crs 30 0 Skipworth, C 05/12-07/03
  36696 CHEM 120 B07 3.00 COLLEGE CHEMISTRY I Bowling Green N/A N/A KTH 4061 MTWR 10:00 am-12:00 pm 10 20 Maddox, J 06/02-07/03
Environmental Science-- Fullfills Colonnade Category...E-NS: Natural & Physical Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41739 ENV 280 M70 3.00 INTRO/ENVIRONMENTAL SCI WEB N/A N/A WEB  WKU Web Crs 13 7 Macy, G 05/12-05/30
Exercise Science-- Fullfills Colonnade Category...E-NS: Natural & Physical Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  33496 EXS 223 C71 3.00 INTRO TO EXERCISE SCIENCE WEB N/A Yes WEB  WKU Web Crs 13 2 McGee, D 06/02-07/25
Geography & Environment-- Fullfills Colonnade Category...E-NS: Natural & Physical Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 38642 GEOG 103 970 3.00 OUR DYNAMIC PLANET On Demand N/A Yes TBA  TBA 0 20 Nemon, A www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  42574 GEOG 280 A70 4.00 ENVIRONMENT SCI SUSTAINABILITY WEB $10 N/A TBA  WKU Web Crs 10 10 Rasbold, G 06/02-07/18
Geology-- Fullfills Colonnade Category...E-NS: Natural & Physical Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42575 GEOL 103 C70 3.00 OUR DYNAMIC PLANET WEB N/A N/A TBA  WKU Web Crs 7 23 Gani, N 07/07-08/01
  41768 GEOL 111 A70 3.00 THE EARTH WEB N/A N/A TBA  WKU Web Crs 13 7 Crowder, M 06/02-06/27
  42628 GEOL 112 001 3.00 EARTH'S PAST AND FUTURE WEB N/A N/A TBA  WKU Web Crs 4 16 Gani, M 07/07-08/01
 R 42314 GEOL 250 970 3.00 ENVIRONMENTAL GEOLOGY On Demand N/A Yes TBA  TBA 0 20 Gani, N www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Meteorology-- Fullfills Colonnade Category...E-NS: Natural & Physical Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41784 METR 121 C71 0.00 METEOROLOGY WEB N/A N/A TBA  WKU Web Crs 12 8 Durkee, J 07/07-07/25
Lab section for METR 121. Must register for METR Lab (41784) & Lecture (41783)
  41783 METR 121 C75 3.00 METEOROLOGY WEB N/A N/A TBA  WKU Web Crs 12 8 Durkee, J 07/07-07/25
Lab, Clinical or additional class required with above class.
Psychological Sciences-- Fullfills Colonnade Category...E-NS: Natural & Physical Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41008 PSYS 160 B70 3.00 INTRO BIOPSYCHOLOGY WEB N/A Yes WEB  WKU Web Crs 6 19 Baylis, L 06/02-06/27
African-American Studies-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42392 AFAM 190 M81 3.00 AFRICAN AMER EXPERIENCE Foreign/Study N/A N/A TBA MTWRF TBA 0 16 TBA 05/12-08/08
Agriculture - General-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42261 AGRI 108 970 3.00 RURAL SOCIOLOGY On Demand N/A Yes TBA  TBA 0 20 Kingery, T www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Citizenship & Social Justice-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42262 CSJ 200 970 3.00 INTRODUCTION TO SOCIAL JUSTICE On Demand N/A Yes TBA  TBA 0 20 Brooks, M www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Criminology-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42594 CRIM 101 700 3.00 INTRO TO CRIMINAL JUSTICE WEB N/A N/A TBA  WKU Web Crs 11 9 Smith, J 06/02-06/27
 R 42660 CRIM 101 970 3.00 INTRO TO CRIMINAL JUSTICE On Demand N/A Yes TBA  TBA 0 20 Maksuta, K www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Economics (Univ)-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  40868 ECON 150 A70 3.00 INTRODUCTION TO ECONOMICS WEB $45 N/A WEB  WKU Web Crs 8 7 Locke, S 06/02-06/27
  40417 ECON 202 B75 3.00 PRIN ECONOMICS-MICRO WEB $45 N/A TBA  WKU Web Crs 13 2 Wilson, D 06/02-06/20
  35092 ECON 202 M75 3.00 PRIN ECONOMICS-MICRO WEB $45 N/A TBA  WKU Web Crs 7 8 Hettinger, K 05/12-05/30
  40366 ECON 203 C75 3.00 PRINCIPLES OF ECONOMICS-MACRO WEB $45 N/A TBA  WKU Web Crs 0 25 Owens, K 07/07-07/25
Finance-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  35028 FIN 161 M70 3.00 PERSONAL FINANCE WEB $45 Yes WEB  WKU Web Crs 10 20 Jones, Z 05/12-07/03
This course will be primarily offered using web-based delivery. Class material will be presented asynchronously and students may complete when their schedule permits. Students who take this course must have a modern personal computer and internet access (Broadband is desirable but not required).
Political Science-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42675 PS 110 700 3.00 AMERICAN NATIONAL GOVT WEB N/A N/A TBA  WKU Web Crs 3 12 Thomas, M 07/07-08/01
 R 41908 PS 110 970 3.00 AMERICAN NATIONAL GOVT On Demand N/A Yes TBA  TBA 0 20 Kiasatpour, S www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
 R 36152 PS 250 970 3.00 INTERNATIONAL POLITICS On Demand N/A Yes TBA  TBA 0 20 Kiasatpour, S www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Psychological Sciences-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41829 PSYS 100 B70 3.00 INTRO PSY WEB N/A Yes WEB  WKU Web Crs 2 23 Baylis, G 06/02-06/27
PSYS 100 is equivalent to PSY 100.
  42581 PSYS 100 C70 3.00 INTRO PSY WEB N/A N/A WEB  WKU Web Crs 2 23 Sanford, P 07/07-08/01
PSYS 100 is equivalent to PSY 100
  42583 PSYS 220 B70 3.00 DEVELOPMENTAL PSYCHOLOGY WEB N/A Yes WEB  WKU Web Crs 0 25 Lickenbrock, D 06/02-06/20
PSYS 220 is equivalent to PSY 220
  41830 PSYS 220 M70 3.00 DEVELOPMENTAL PSYCHOLOGY WEB N/A N/A WEB  WKU Web Crs 1 24 Truelove, K 05/12-05/30
PSYS 220 is equivalent to PSY 220.
Psychology-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42171 PSY 100 B70 3.00 INTRO PSY WEB N/A Yes WEB  WKU Web Crs 8 12 Hollis, Q 06/02-06/27
The above course is an Online (Web) course. PSY 100 is equivalent to PSYS 100.
  42172 PSY 100 M70 3.00 INTRO PSY WEB N/A Yes WEB  WKU Web Crs 2 18 Rutledge, K 05/12-07/03
The above course is an Online (Web) course.
  42571 PSY 220 C70 3.00 DEVELOPMENTAL PSYCHOLOGY WEB N/A N/A WEB  WKU Web Crs 3 17 Jant, E 07/07-08/01
The above course is an Online (Web) course.
  41123 PSY 220 M70 3.00 DEVELOPMENTAL PSYCHOLOGY WEB N/A Yes WEB  WKU Web Crs 3 17 Hollis, Q 05/12-06/06
The above course is an Online (Web) course. PSY 220 is equivalent to PSYS 220.
  42570 PSY 220 M71 3.00 DEVELOPMENTAL PSYCHOLOGY WEB N/A N/A WEB  WKU Web Crs 2 18 Jant, E 05/12-06/06
The above course is an Online (Web) course.
Public Health-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  29681 PH 100 M70 3.00 PERSONAL & PUBLIC HEALTH WEB N/A Yes WEB  WKU Web Crs 9 16 Shoemake, A 05/12-05/30
Public Relations-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42615 PR 255 B01 3.00 FUNDAMENTALS OF PUBLIC RELATIO WEB N/A Yes TBA MTWRF 08:00 am-09:20 am 0 25 Momorella, S 06/02-07/18
This class meets via Zoom on the days/times indicated. Please see syllabus or contact instructor for more information.
  42597 PR 255 C01 3.00 FUNDAMENTALS OF PUBLIC RELATIO Bowling Green N/A Yes GRH 3010 MTWRF 01:00 pm-04:15 pm 1 24 Momorella, S 07/07-07/25
Social Work-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  38833 SWRK 101 B70 3.00 FNDTNS OF HUM SVCS WEB N/A N/A WEB  WKU Web Crs 10 10 Cassity Caywood, W 06/02-06/27
Sociology-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42595 SOCL 100 700 3.00 INTRODUCTORY SOCIOLOGY WEB N/A N/A TBA  WKU Web Crs 7 13 Brooks, M 06/02-06/27
  42605 SOCL 100 701 3.00 INTRODUCTORY SOCIOLOGY WEB N/A N/A TBA  WKU Web Crs 6 14 Musalia, J 07/07-08/01
 R 33782 SOCL 100 970 3.00 INTRODUCTORY SOCIOLOGY On Demand N/A Yes TBA  TBA 0 20 Kanan, J www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Sport Management-- Fullfills Colonnade Category...E-SB: Social & Behavioral Sciences
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41283 SPM 200 M70 3.00 INTRO TO SPORT MANAGEMENT WEB N/A N/A WEB  WKU Web Crs 2 28 Obee, T 05/12-06/06
Chemistry-- Fullfills Colonnade Category...E-SL: Science Lab
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  36697 CHEM 121 B04 2.00 LAB COLLEGE CHEMISTRY I Bowling Green $45 N/A OCH 2010 TR 01:00 pm-03:30 pm 10 14 Maddox, J 06/02-07/03
Geology-- Fullfills Colonnade Category...E-SL: Science Lab
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41769 GEOL 113 A70 1.00 THE EARTH LABORATORY WEB $15 N/A TBA  WKU Web Crs 11 9 Crowder, M 06/02-06/27
  42629 GEOL 114 001 1.00 EARTH'S PAST AND FUTURE LAB WEB $15 N/A TBA  WKU Web Crs 3 17 Gani, M 07/07-08/01
English-- Fullfills Colonnade Category...F-AH: Literary Studies
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 33267 ENG 200 970 3.00 INTRODUCTION LITERATURE On Demand N/A Yes TBA  TBA 0 15 Pennavaria, K www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  03571 ENG 200 B70 3.00 INTRODUCTION LITERATURE WEB N/A N/A WEB  WKU Web Crs 26 1 Berry, E 06/02-07/03
C  01179 ENG 200 B71 3.00 INTRODUCTION LITERATURE WEB N/A N/A WEB  WKU Web Crs 27 0 Folk, J 06/02-07/03
  42747 ENG 200 C71 3.00 INTRODUCTION LITERATURE WEB N/A N/A WEB  WKU Web Crs 0 27 Branham, K 07/07-08/08
  19456 ENG 200 M70 3.00 INTRODUCTION LITERATURE WEB N/A N/A WEB  WKU Web Crs 26 1 Jaggers, P 05/12-06/06
C  41889 ENG 200 M72 3.00 INTRODUCTION LITERATURE WEB N/A N/A WEB  WKU Web Crs 27 0 Knoll, G 05/12-05/30
  42636 ENG 200 M73 3.00 INTRODUCTION LITERATURE WEB N/A N/A WEB TW 05:30 pm-08:30 pm 7 20 Hughes, S 05/12-06/13
^Students meet through Zoom on the scheduled days & times. Additional instructional minutes are met through asynchronous online instruction.^
 R 38287 ENG 200 M81 3.00 INTRODUCTION LITERATURE Foreign/Study N/A N/A TBA  TBA 0 25 TBA 05/12-08/08
In-country dates: June 28-July 18. The office of GLIA will register accepted students in the course. Refer to www.wku.edu/flsa/programs for more information on program details and billing.
 R 35639 ENG 200 M82 3.00 INTRODUCTION LITERATURE Foreign/Study N/A N/A TBA  TBA 0 25 TBA 05/12-08/08
In-country dates: June 28-July 18. The office of GLIA will register accepted students in the course. Refer to www.wku.edu/flsa/programs for more information on program details and billing.
Modern Languages-- Fullfills Colonnade Category...F-AH: Literary Studies
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42477 MLNG 200 C81 3.00 INTRO TO GLOBAL LITERATURE Foreign/Study N/A N/A TBA  TBA 0 15 TBA 07/07-08/01
KIIS Title: Mexico & the Yucatan Peninsula
Communication-- Fullfills Colonnade Category...F-OC: Human Communications
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41985 COMM 145 B01 3.00 FUND SPEAKING/COMMUNICATION WEB N/A N/A TBA  WKU Web Crs 14 11 McClanahan, J 06/02-06/27
  42250 COMM 145 C01 3.00 FUND SPEAKING/COMMUNICATION WEB $5 N/A TBA  WKU Web Crs 10 15 Elder, C 07/07-07/25
 R 42412 COMM 145 D01 3.00 FUND SPEAKING/COMMUNICATION Bowling Green N/A N/A GRH 1002 MTWRF 12:30 pm-02:10 pm 0 25 TBA 07/08-08/07
Class restricted to Summer Scholar students This section of COMM 145 must be taken with IDST199 41369
 R 41377 COMM 145 D06 3.00 FUND SPEAKING/COMMUNICATION Bowling Green N/A N/A GRH 3002 MTWRF 09:30 am-11:10 am 0 25 Hughes, G 07/08-08/07
Class restricted to Summer Scholar students This section of COMM 145 must be taken with FILM 105 41391
  42653 COMM 145 M01 3.00 FUND SPEAKING/COMMUNICATION WEB $5 N/A TBA  WKU Web Crs 9 16 Elder, C 05/12-06/06
  42249 COMM 145 M76 3.00 FUND SPEAKING/COMMUNICATION WEB $5 N/A TBA  WKU Web Crs 4 21 McClanahan, J 05/12-05/30
Mathematics (Univ)-- Fullfills Colonnade Category...F-QR: Quantitative Reasoning
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42257 MATH 109E 970 3.00 GENERAL MATH On Demand N/A Yes TBA  TBA 0 20 Jones, M www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
C  42215 MATH 109E M70 3.00 GENERAL MATH WEB N/A Yes WEB  WKU Web Crs 30 0 Brockman, J 05/12-06/13
The above course is an Online (Web) course.
 R 39956 MATH 115 970 3.00 APPLIED COLLEGE ALGEBRA On Demand N/A Yes TBA  TBA 0 20 Ayers, R www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  42219 MATH 115E C70 3.00 APPLIED COLLEGE ALGEBRA WEB N/A Yes WEB  WKU Web Crs 8 22 Billingsley, E 07/07-08/08
The above course is an Online (Web) course. This course does not serve as a prerequisite for MATH 117 Trigonometry.
 R 35280 MATH 116 970 3.00 COLLEGE ALGEBRA On Demand N/A Yes TBA  TBA 0 20 Brockman, J www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  42220 MATH 116E C70 3.00 COLLEGE ALGEBRA WEB N/A N/A WEB  WKU Web Crs 15 15 Jackson, M 07/07-08/08
The above course is an Online (Web) course.
  42216 MATH 116E M70 3.00 COLLEGE ALGEBRA WEB N/A Yes WEB  WKU Web Crs 23 7 Emanuel, L 05/12-06/13
The above course is an Online (Web) course.
 R 39347 MATH 117 970 3.00 TRIGONOMETRY On Demand N/A Yes TBA  TBA 0 20 Ayers, R www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  40431 MATH 117 C70 3.00 TRIGONOMETRY WEB N/A N/A WEB  WKU Web Crs 22 18 Dunkum, M 07/07-08/08
The above course is an Online (Web) course.
 R 40926 MATH 136 970 4.00 CALCULUS I On Demand N/A Yes TBA  TBA 0 25 Ozer, A www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  41811 MATH 136 B70 4.00 CALCULUS I WEB N/A Yes WEB MTWRF 10:30 am-12:05 pm 9 26 Nguyen, T 06/02-07/18
The above course is an Online (Web) course. This course will meet on Zoom on the specified dates and time. Check the syllabus or contact instructor for details.
 R 40489 MATH 183 970 3.00 INTRODUCTORY STATISTICS On Demand N/A Yes TBA  TBA 0 20 Ayers, R www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
History-- Fullfills Colonnade Category...F-SB: World History
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 41528 HIST 101 970 3.00 WORLD HISTORY I On Demand N/A Yes TBA  TBA 0 20 Serafini, D www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  42271 HIST 101 B70 3.00 WORLD HISTORY I WEB N/A N/A WEB  WKU Web Crs 14 11 Serafini, D 06/02-07/03
  41270 HIST 101 M70 3.00 WORLD HISTORY I WEB N/A N/A WEB  WKU Web Crs 8 17 Serafini, D 05/12-05/30
 R 41991 HIST 102 970 3.00 WORLD HISTORY II On Demand N/A Yes TBA  TBA 0 25 Rosa, A www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  42272 HIST 102 B71 3.00 WORLD HISTORY II WEB N/A N/A WEB  WKU Web Crs 13 12 Rosa, A 06/02-06/20
  41853 HIST 102 M71 3.00 WORLD HISTORY II WEB N/A N/A WEB  WKU Web Crs 12 13 Brown, K 05/12-06/06
English-- Fullfills Colonnade Category...F-W1: College Composition
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 33266 ENG 100 970 3.00 INTRO TO COLLEGE WRITING On Demand N/A Yes TBA  TBA 0 25 Holder, L www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  01151 ENG 100 B71 3.00 INTRO TO COLLEGE WRITING WEB N/A Yes WEB  WKU Web Crs 17 5 Winters, D 06/02-07/03
Communication-- Fullfills Colonnade Category...F-W2: Writing in the Disciplines
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
C  40453 COMM 200 B70 3.00 COMM FOUNDATIONS WEB N/A Yes TBA  WKU Web Crs 26 -1 Ray, E 06/02-06/27
C  42176 COMM 200 C01 3.00 COMM FOUNDATIONS WEB N/A Yes TBA  WKU Web Crs 25 0 Ray, E 07/07-08/01
  40452 COMM 200 M75 3.00 COMM FOUNDATIONS WEB N/A Yes TBA  WKU Web Crs 24 1 Payne, H 05/12-06/06
English-- Fullfills Colonnade Category...F-W2: Writing in the Disciplines
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 33301 ENG 300 970 3.00 WRITING IN THE DISCIPLINES On Demand N/A Yes TBA  TBA 0 25 Heintzman, A www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
  42324 ENG 300 B72 3.00 WRITING IN THE DISCIPLINES WEB N/A N/A WEB  WKU Web Crs 21 1 Hays, D 06/02-07/03
  19845 ENG 300 C70 3.00 WRITING IN THE DISCIPLINES WEB N/A N/A WEB  WKU Web Crs 18 4 Otto, P 07/07-08/08
  04479 ENG 300 M70 3.00 WRITING IN THE DISCIPLINES WEB N/A N/A WEB  WKU Web Crs 18 4 Johnson, L 05/12-06/13
C  41736 ENG 300 M71 3.00 WRITING IN THE DISCIPLINES WEB N/A N/A WEB  WKU Web Crs 22 0 Alvarez, F 05/12-06/13
Psychological Sciences-- Fullfills Colonnade Category...F-W2: Writing in the Disciplines
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42710 PSYS 300 970 3.00 WRITING IN PSYCH SCIENCES On Demand N/A N/A TBA  TBA 0 20 Shake, M www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Hospitality Mgt/Dietetics-- Fullfills Colonnade Category...K-IE: International Experience
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42728 HMD 476 M81 3.00 GLOBAL HOSPITALITY AND CUISINE Foreign/Study N/A N/A FRANCE  TBA 17 3 Kim, S 05/12-08/08
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. In-country dates: May 17-31, 2025. Students must submit application prior to acceptance. GLIA will register accepted students in the course. The payment is due according to
program description. Course assignments with deadlines prior to start of WKU Summer Term will be stated in syllabus.
Interior Design Fashion Merch-- Fullfills Colonnade Category...K-IE: International Experience
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42436 IDFM 426 C81 3.00 DESIGN MARKET TRENDS Foreign/Study N/A N/A TBA  TBA 0 12 TBA 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Advertising-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
C  40949 AD 240 B70 3.00 ADVERTISING IN A DIGITAL WORLD WEB N/A N/A TBA  WKU Web Crs 25 0 Shaluta, C 06/02-07/03
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Anthropology-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42591 ANTH 388 700 3.00 FOODWAYS WEB N/A N/A TBA  WKU Web Crs 0 10 Hudepohl, K 05/12-06/13
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  42603 ANTH 388 701 3.00 FOODWAYS WEB N/A Yes TBA  WKU Web Crs 1 9 Valenzuela, R 06/02-07/03
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  42610 ANTH 388 702 3.00 FOODWAYS WEB N/A Yes TBA  WKU Web Crs 4 6 Valenzuela, R 07/07-08/08
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Art-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42724 ART 318 M80 3.00 ART AND LANDSCAPE Study Away N/A N/A NY  TBA 12 8 Jordan, G 05/12-08/08
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. Faculty-Led travel portion dates: June 17-25, 2025. Students must submit an application with an initial payment prior to acceptance. WKU Global will register accepted students in
the course. The balance is due according to the program description. Course assignments will be stated in syllabus with deadlines prior to the start of the WKU Summer Session.
Criminology-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
C  42604 CRIM 434 700 3.00 ORGANIZED CRIME WEB N/A N/A TBA  WKU Web Crs 22 -2 Kanan, J 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Economics (Univ)-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41826 ECON 430 M75 3.00 ENV & RESOURCE ECONOMICS WEB $45 N/A TBA  WKU Web Crs 8 2 Byl, J 05/12-06/13
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Folk Studies-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42611 FLK 388 700 3.00 FOODWAYS WEB N/A N/A TBA  WKU Web Crs 1 9 Hudepohl, K 05/12-06/13
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  42613 FLK 388 701 3.00 FOODWAYS WEB N/A Yes TBA  WKU Web Crs 1 9 Valenzuela, R 06/02-07/03
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  42614 FLK 388 702 3.00 FOODWAYS WEB N/A Yes TBA  WKU Web Crs 1 9 Valenzuela, R 07/07-08/08
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Geography & Environment-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 42403 GEOG 452 B02 3.00 KARST HYDROGEOLOGY Special Locat N/A N/A MAMTH  TBA 3 2 North, L 06/02-06/06
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. Karst Field Studies Program field course. Visit www.karstfieldstudies.com or email Leslie.North@wku.edu for registration instructions.
C R 42550 GEOG 452 B03 3.00 CAVE SURVEY & CARTOGRAPHY Special Locat N/A N/A MAMTH  TBA 2 -1 North, L 06/08-06/13
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. Karst Field Studies Program field course. Visit www.karstfieldstudies.com or email Leslie.North@wku.edu for registration instructions.
 R 42404 GEOG 452 M01 3.00 KARST GEOLOGY OF MAMMOTH CAVE Special Locat N/A Yes MAMTH  TBA 2 3 North, L 07/13-07/18
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. Karst Field Studies Program field course. Visit www.karstfieldstudies.com or email Leslie.North@wku.edu for registration instructions.
Health Care Administration-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42310 HCA 347 C70 3.00 INTERNATIONAL HEALTH CARE WEB N/A N/A WEB  WKU Web Crs 18 2 Reece, M 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Hospitality Mgt/Dietetics-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  39771 HMD 271 M70 3.00 TOURISM PLANNING & DEVL WEB N/A Yes TBA  WKU Web Crs 6 24 Kim, S 06/02-06/27
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Library Media Education-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42237 LME 448 B70 3.00 TECHNOLOGY APPS IN EDUCATION WEB N/A Yes WEB  WKU Web Crs 8 22 Logsdon, J 06/02-07/18
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Music-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  33200 MUS 277 B75 3.00 WORLD MUSIC WEB N/A Yes WEB  WKU Web Crs 14 5 Berry, M 06/02-06/20
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Political Science-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42657 PS 357 700 3.00 U S FOREIGN POLICY WEB N/A N/A TBA  WKU Web Crs 5 7 Kiasatpour, S 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Recreation Park Nonprofit Admn-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  40848 REC 338 B71 3.00 PARKS, REC. & QUALITY OF LIFE WEB N/A N/A WEB  WKU Web Crs 9 26 Knackmuhs, E 06/02-06/20
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. Students should complete 21 hours of Foundations & Explorations coursework of have junior status before enrolling in a Connections course. The above course is an Online (Web)
course.
Religious Studies-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42643 RELS 306 B71 3.00 ISLAM WEB N/A Yes WEB  WKU Web Crs 2 23 Arjana, S 06/02-06/20
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
School of Professional Studies-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 41296 SPS 400 970 3.00 GLOBAL CITIZENSHIP On Demand N/A Yes TBA  TBA 0 20 Ghezal, S www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Sociology-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42606 SOCL 240 700 3.00 GLOBAL SOCIAL PROBLEMS WEB N/A N/A TBA  WKU Web Crs 3 17 Musalia, J 07/07-07/25
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Sport Management-- Fullfills Colonnade Category...K-LG: Local to Global
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
C  42579 SPM 335 700 3.00 GLOBAL PERSPECTIVES IN SPORT WEB N/A N/A WEB  WKU Web Crs 20 0 Upright, P 06/02-06/27
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  42209 SPM 335 C70 3.00 GLOBAL PERSPECTIVES IN SPORT WEB N/A N/A TBA  WKU Web Crs 8 12 Forsythe, S 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
American Sign Language-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41755 ASL 302 M70 3.00 DEAF CULTURE IN AMERICA WEB N/A N/A WEB  WKU Web Crs 15 17 Bryant, H 05/12-06/06
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Communication-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42178 COMM 365 B01 3.00 INTERCULTURAL COMMUNICATION WEB N/A N/A TBA  WKU Web Crs 12 8 Daugherty, C 06/02-06/27
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Criminology-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42666 CRIM 361 700 3.00 RACE, CLASS AND CRIME WEB N/A N/A TBA  WKU Web Crs 5 15 Maksuta, K 05/12-06/13
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Dance-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42616 DANC 360 M71 3.00 DANCE IN CULTURE WEB N/A Yes WEB  WKU Web Crs 4 16 McKinley, M 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Economics (Univ)-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 41623 ECON 375 970 3.00 MORAL ISSUES OF CAPITALISM On Demand $45 Yes TBA  TBA 0 20 Owens, K www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
History-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42642 HIST 447 M71 3.00 HISTORY OF AMER POP CULTURE WEB N/A N/A WEB  WKU Web Crs 7 18 Olson, A 05/12-06/20
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Interdisciplinary Studies(BIS)-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41737 IDST 390 C75 3.00 IDST APPLICATIONS WEB N/A Yes TBA  WKU Web Crs 4 20 Basham, C 07/07-08/08
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Interior Design Fashion Merch-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  36681 IDFM 431 B70 3.00 CLOTHING & HUMAN BEHAVIOR WEB N/A Yes TBA  WKU Web Crs 5 25 Barber, B 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Music-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  40537 MUS 320 B71 3.00 ROCK AND ROLL WEB N/A N/A WEB  WKU Web Crs 24 6 Herman, M 06/02-06/20
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  39406 MUS 320 C77 3.00 ROCK AND ROLL WEB N/A N/A WEB  WKU Web Crs 12 13 Schallert, G 07/07-07/25
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  40044 MUS 322 B71 3.00 BLUES MUSIC WEB N/A N/A WEB  WKU Web Crs 12 18 Martin, J 06/02-06/20
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
 R 42448 MUS 327 C82 3.00 MUSIC HISTORY II Foreign/Study N/A N/A TBA  TBA 0 10 TBA 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Philosophy-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42674 PHIL 211 700 3.00 WHY ARE BAD PEOPLE BAD WEB N/A N/A TBA  WKU Web Crs 12 3 Anton, A 05/12-06/13
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Psychological Sciences-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 38084 PSYS 350 970 3.00 SOCIAL PSYCHOLOGY On Demand N/A Yes TBA  TBA 0 20 Wichman, A www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. PSYS 350 is equivalent to PSY 350
  40394 PSYS 350 B70 3.00 SOCIAL PSYCHOLOGY WEB N/A N/A WEB  WKU Web Crs 5 20 Wichman, A 06/02-06/20
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. PSYS 350 is equivalent to PSY 350
  42214 PSYS 350 C70 3.00 SOCIAL PSYCHOLOGY WEB N/A N/A WEB  WKU Web Crs 6 19 Wichman, A 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  39830 PSYS 350 M70 3.00 SOCIAL PSYCHOLOGY WEB N/A N/A WEB  WKU Web Crs 1 24 Wichman, A 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. PSYS 350 is equivalent to PSY 350
Psychology-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42169 PSY 350 M70 3.00 SOCIAL PSYCHOLOGY WEB N/A Yes WEB  WKU Web Crs 10 10 Yoon, Y 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
The above course is an Online (Web) course.
Public Health-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  36602 PH 365 M70 3.00 HUMAN SEXUALITY WEB N/A N/A WEB  WKU Web Crs 7 23 TBA 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  37999 PH 447 M70 3.00 HUMAN VALUES/HEALTH SCI WEB N/A Yes WEB  WKU Web Crs 14 11 Shoemake, A 05/12-06/20
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Religious Studies-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 40940 RELS 305 970 3.00 CHRISTIANITY On Demand N/A Yes TBA  TBA 0 25 Mukonyora, I www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Social Work-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41851 SWRK 311 M70 3.00 INTERGENERATIONAL TRAUMA WEB N/A Yes WEB  WKU Web Crs 18 2 Mallinger, G 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Theatre-- Fullfills Colonnade Category...K-SC: Social & Cultural
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42734 THEA 341 C75 3.00 CULTURE AND PERFORMANCE WEB N/A N/A TBA  WKU Web Crs 0 20 Gilly-Forrer, C 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Anthropology-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42612 ANTH 342 701 3.00 PEOPLES/CULTURES CARIBBEAN WEB N/A N/A TBA  WKU Web Crs 0 10 Hudepohl, K 06/02-07/03
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Criminology-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 40271 CRIM 430 970 3.00 SYSTEMS OF JUVENILE JUSTICE On Demand N/A Yes TBA  TBA 0 20 Drummond, H www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Entrepreneurship-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
C  41801 ENT 312 C70 3.00 ENTREPRENEURSHIP WEB $45 N/A WEB  WKU Web Crs 30 0 Peake, W 07/07-08/08
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. The wait list for ENT 312 is through TopNet. DO NOT contact instructor.
Folk Studies-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42667 FLK 342 700 3.00 PEOPLES/CULTURES CARIBBEAN WEB N/A N/A TBA  WKU Web Crs 0 10 Hudepohl, K 06/02-07/03
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Health Care Administration-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41210 HCA 340 C70 3.00 HEALTH CARE ORG/MGT WEB N/A N/A WEB  WKU Web Crs 12 8 Eaton, M 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Hospitality Mgt/Dietetics-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41567 HMD 211 B70 3.00 HUMAN NUTRITION WEB N/A Yes TBA  WKU Web Crs 17 13 Payne-Emerson, H 06/02-06/27
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  38725 HMD 211 M72 3.00 HUMAN NUTRITION WEB N/A Yes TBA  WKU Web Crs 10 20 Embry, A 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Instructional Design-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42238 ID 475 C70 3.00 MULTIMEDIA FOR TRAINING WEB N/A Yes TBA  WKU Web Crs 2 28 Paganelli, A 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Manufacturing Engineering Tech-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 41552 MFGE 303 970 3.00 FOOD LAWS AND REGULATIONS On Demand N/A Yes TBA  TBA 0 20 Khouryieh, H www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Music-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  41814 MUS 321 C71 3.00 COUNTRY MUSIC WEB N/A N/A WEB  WKU Web Crs 16 14 TBA 07/07-07/25
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Political Science-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
C  42658 PS 304 700 3.00 STATE GOVERNMENT WEB N/A N/A TBA  WKU Web Crs 6 0 Turner, J 05/12-06/06
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
Psychological Sciences-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  40869 PSYS 353 C70 3.00 PSYCHOLOGY OF PREJUDICE WEB N/A N/A WEB  WKU Web Crs 13 12 Wichman, A 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  38697 PSYS 423 M70 3.00 PSY ADULT/AGING WEB N/A Yes WEB  WKU Web Crs 7 18 Mienaltowski, A 05/12-05/30
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. This course is taught entirely online and does not require travel to the WKU main campus.
Recreation Park Nonprofit Admn-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
  42253 REC 330 C70 3.00 FOUNDATIONS OF OUTDOOR REC WEB N/A Yes WEB  WKU Web Crs 7 28 Poff, R 07/07-08/01
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
  41173 REC 420 B70 3.00 RECREATION AND TOURISM WEB N/A Yes WEB  WKU Web Crs 3 27 Poff, R 06/02-07/03
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. Students should complete 21 hours of Foundations & Explorations coursework or have a junior status before enrolling in a Connections course. The above course is an Online (Web)
course.
School of Professional Studies-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 39403 SPS 300 C75 3.00 SYSTEMS THINKING WEB N/A N/A WEB  WKU Web Crs 6 14 Ghezal, S 07/07-08/08
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. Restricted to WFA Scholarship students.
  40818 SPS 300 C76 3.00 SYSTEMS THINKING WEB N/A N/A WEB  WKU Web Crs 3 17 Ghezal, S 07/07-08/08
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course. This section is open to ALL students.
Sociology-- Fullfills Colonnade Category...K-SY: Systems
    CRN Subj Crse Sec Cred Title Campus Fee Sylbi? Location Day(s) Time Act Rem Instructor Course Dates
 R 36850 SOCL 342 970 3.00 AGING IN SOCIETY On Demand N/A Yes TBA  TBA 0 15 Krull, A www.wku.edu/ondemand
The above is a flex-paced, web course. You MUST register with WKU On Demand. For information see www.wku.edu/ondemand, call 270-745-4158. Advisors please do not override.
Students should complete 21 hours of Foundations & Explorations coursework or have junior status before enrolling in a Connections course.
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